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About this Lesson:

Carbohydrates are one of the most important organic molecules found in living
organisms and come in many different forms and sizes. This lesson will introduce the
role of carbohydrates in living systems and will cover the carbohydrate taxonomy,
including monosaccharides, disaccharides, oligosaccharides, and polysaccharides.

Using Maestro, students will learn how to use the 2D sketcher to build simple
carbohydrate molecules, visualize the shapes of simple sugars, as well as build and
compare the structures of cellulose and starch in the Maestro graphical interface.
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Learning Objectives:

● Define the term carbohydrate and explain its importance in living organisms
● Describe the carbohydrate taxonomy and identify examples of

monosaccharides, disaccharides, and polysaccharides
● Examine simple carbohydrate structures in different 2D and 3D representations
● Build and compare complex carbohydrate structures using the Polymer Builder

Standards:

● NY State Core Curriculum:
○ Organic Chemistry (Section 3.1ff)

● Connections to AP Biology:
○ Biological Macromolecules -  (Unit 1)

● IBDP Chemistry:
○ Biochemistry - Carbohydrates (Optional Topic B4)

● IBDP Biology:
○ Carbohydrates and Lipids (Core Topic 2.3)

● ETS Chemistry GRE:
○ Special Topics - Carbohydrates (Section 3F)

● AAMC MCAT:
○ Biological and Biochemical Foundations of Living Systems (1D)

Assessments:

The following types of formative assessments are embedded in this lesson:

● Assessment of student understanding through discussion of warm-up questions and
filling in any knowledge gaps about the different types and properties of carbohydrates

● Visual assessment of student-generated simple sugars and complex carbohydrates

Warm-Up Questions: To be done on their own or at the beginning of class

Read the Khan Academy article on Carbohydrates and answer the following questions:

1) How does our body get energy from complex carbohydrates?

2) What are the two main functions of polysaccharides?
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Lesson Outline:
1. What you will need for this lesson - p. 3
2. Introduction to carbohydrates - p. 5
3. Carbohydrate taxonomy - p. 6
4. Types and properties of polysaccharides - p. 9
5. Molecular visualization of carbohydrates - p. 11
6. Summary, Additional Resources, and References - p. 21
7. Glossary of Terms - p. 21

1. What you will need for this lesson

1. Go to the ‘Data’ folder and open your
Class Folder found on the virtual
cluster’s desktop.

2. Right-click on the folder called
“Carbohydrates” and copy folder to
Desktop

● Here, you will find the lesson
plan, worksheet, and any
additional resources

Figure 1-1. Open Maestro.

3. Open Maestro
a. See Starting Maestro if you

need help
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Figure 1-2. Change Working Directory option.

4. Go to File > Change Working
Directory

5. Find your “Carbohydrates” folder that
you duplicated to your Desktop, and
click Choose

Figure 1-3. Save Project panel.

6. Next, go to File > Save Project As
7. Type “carbohydrates” and click Save

a. The project will be titled
carbohydrates.prj

Figure 1-4. Choose the best mouse option for
your set up.

8. Finally, check your Mouse Actions
a. PC : Edit > Customize Mouse

Actions
b. Mac : Workspace >

Customize Mouse Actions
9. Make sure you have the best option

chosen for your set up. This lesson
was written with a three-button mouse
with a scroll wheel, meaning the scroll
wheel is a button as well as a wheel. If
you do not have a mouse, choose
Trackpad.
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2. Introduction to carbohydrates
When you first think of the word carbohydrates, chances are you thought of food!

Potatoes, rice, and pasta are all rich sources of carbohydrates and happen to be a part
of our daily diet. Along with proteins and fats, carbohydrates are one of three main
nutrients found in our food and drinks and they play a vital role in the human body.
Carbohydrates provide the body with glucose, a source of quick, short-term energy that
is used to support various bodily functions and physical activity. Glucose can be used
immediately by the body or it can be stored in the liver and muscles for later use.

Let’s begin our discussion of carbohydrates by examining the elements from
which carbohydrates are built. If we look at the name, carbohydrate, we can break it
down to two parts: carbo- and hydrate-. The carbo- part tells us that the element carbon
is a main component in the structure of carbohydrates. The hydrate- part means water
and originates from the Greek language. Water, as we all know, is composed of
hydrogen and oxygen atoms. Hence, carbohydrates are composed of carbon,
hydrogen, and oxygen atoms, and are what we call, biological macromolecules.
While there are many different types of carbohydrates, they all have the generic formula
Cn(H2O)n.

Figure 2-1. Carbohydrate taxonomy chart

3. Carbohydrate taxonomy
Let’s continue our exploration of carbohydrates. As you can see from Figure 2-1,

carbohydrates exist in many different shapes and sizes. They can exist as simple
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sugars, such as monosaccharides and disaccharides, or they can exist in more
complex forms, like oligosaccharides and polysaccharides.

3.1 Monosaccharides
Monosaccharides are carbohydrates composed of one type of sugar.

Monosaccharides have a formula of (CH2O)n and typically contain three to seven carbon
atoms. Most of the oxygen atoms found in monosaccharides are in hydroxyl (OH)
groups, but one of them is part of a carbonyl group (C=O). The position of the carbonyl
group can be used to categorize the monosaccharides: if the monosaccharide has an
aldehyde group (R-CH=O), the sugar is known as an aldose; if the monosaccharide has
a ketone (R-C=O-R), the sugar is known as an ketose.

Apart from glucose, other monosaccharides include fructose and galactose.
Fructose is the natural sugar found in fruits, while galactose can be found in abundance
in dairy products. What’s interesting is that glucose, fructose, and galactose are all
isomers. This means that they all have the same chemical formula, but the way the
atoms are arranged in each carbohydrate differ. Figure 3-1 illustrates the structures of
glucose, fructose, and galactose in a side-by-side comparison.

Figure 3-1. Structures of glucose, fructose and galactose
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Example #1. Look closely at Figure 3-1. Circle the aldehyde and ketone groups in each
carbohydrate. Categorize glucose, fructose, and galactose as an aldose or ketose.
Glucose and galactose are aldose sugars, while fructose is a ketose.

Figure 3-1 does not paint a complete picture. This is because glucose is a
monosaccharide that can exist in two main forms: D-glucose (or dextrose) and
L-glucose. D-glucose and L-glucose are enantiomers, which means that their
molecular structures are mirror images of each other. The key difference is that in
D-glucose, three hydroxyl groups and one hydrogen group are on the right side
whereas in L-glucose, the three hydroxyl groups and one hydrogen group are on the left
side.

Example #2. Is the glucose structure in Figure 3-1 in D- form or L-form?
In D form (D-glucose).

Unlike L-glucose, D-glucose occurs more widely in nature and is thus one of the
most important aldohexose sugars found in living organisms. D-glucose contains two
further isomers: alpha-D-glucose and beta-D-glucose. The key difference between
alpha (α) and beta (β) D-glucose is the orientation of the hydroxyl groups attached to
the first and fourth carbon atoms. Alpha-D-glucose has hydroxyl groups in the 1 and 4
positions on the same side. Beta-D-glucose has hydroxyl groups in the 1 and 4
positions on opposite sides. Figure 3-2 demonstrates this configuration.

Figure 3-2. Molecular structures of alpha-D-glucose and beta-D-glucose
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3.2 Disaccharides
A disaccharide is a carbohydrate formed when two monosaccharides are joined

together via a condensation reaction (also known as a dehydration reaction). In this
process, the hydroxyl group of one monosaccharide combines with the hydrogen of
another, releasing a water molecule in the process and forming a covalent bond called a
glycosidic linkage. The reaction that takes place between two monosaccharides is
demonstrated in Figure 3-3.

Figure 3-3. Condensation reaction between glucose and fructose to form sucrose.
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3.3 Oligosaccharides and polysaccharides
Oligosaccharides and polysaccharides are both made up of monosaccharides.

The main difference between the two is that oligosaccharides are made out of a fewer
number of monosaccharides whereas polysaccharides are made out of a larger
number of monosaccharides. A number of oligosaccharides can also form multiple
linkages to produce a polysaccharide. Cellulose, starch, and glycogen are well-known
examples of polysaccharides. These complex macromolecules are an important source
of energy in animal cells, and form a structural component of a plant cell.

Polysaccharides can either be a straight chain of monosaccharides known as
linear polysaccharides, or they can also form branches known as a branched
polysaccharide. Figure 3-4 depicts the structures of cellulose, amylose, amylopectin,
and glycogen.

Figure 3-4. Shape and structure of different types of polysaccharides.

Example #3. Take a close examination at Figure 3-4. Which polysaccharide(s) would
you categorize as linear? Which one(s) would you categorize as branched?
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4. Types and properties of polysaccharides
In Section 3, we examined the carbohydrate taxonomy and dived deep into

examples from each taxonomic group. We also learned that polysaccharides are an
important source of energy and structure for animal and plant cells, and we looked at
three main examples: cellulose, starch, and glycogen.

4.1 Types of polysaccharides
Each of the polysaccharides mentioned above are composed of glucose

subunits, and can be referred to as homopolysaccharides. A homopolysaccharide is a
polysaccharide composed of only one type of monosaccharide. A
heteropolysaccharide on the other hand, is a polysaccharide composed of different
types of monosaccharides. One example is hyaluronic acid, which is made up of the
monosaccharides D-glucuronic acid and N-acetyl-glucosamine, and is a natural
substance found in our connective tissues and skin. Hyaluronic acid is also a
glycosaminoglycan (or GAG), a negatively charged polysaccharide that is made up of
repeating disaccharide units. The structure of hyaluronic acid is displayed in Figure 4-1.

Figure 4-1. The repeating disaccharide unit of hyaluronic acid.
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Example #4. Recall from Section 2 that all carbohydrates are made up of carbon,
hydrogen, and oxygen atoms. From Figure 4-1, what do you notice that is different
about the structure of N-acetyl glucosamine? Elaborate below.

4.2 Properties of polysaccharides
Polysaccharides, as you already know, are macromolecules composed of a large

number of monosaccharides. They thus have a high molecular weight. The molecular
weight of polysaccharides can reach as high as 100,000 daltons or more if enough
monosaccharides are joined together. This makes polysaccharides very large, complex
molecules that are hydrophobic and unable to diffuse through cell membranes. They
can pass through membranes only when broken down into their component monomers,
i.e. simple sugars. Similarly, polysaccharides are also not sweet in taste. However,
enzymes such as amylase can break down polysaccharides like amylose, into their
glucose subunits, which do in fact taste sweet.

5. Molecular visualization of carbohydrates
In this activity, you will learn how to build simple monosaccharide units in Maestro, as

well as compare the structures of two different polysaccharides using the graphical user
interface.

Computational Exercise #1: Building carbohydrate biopolymers

This exercise involves three parts:
1) Build a D-glucose molecule using the 2D sketcher
2) Translate the 3D glucose structure to a 2D Fischer projection
3) Build and compare the structures of cellulose and amylose
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Figure 5-1. Opening 2D Sketcher.

Figure 5-2. Drawing D-glucose.

Part 1. Building D-glucose

In Part 1, you will learn how to draw a ‘zigzag’
structure of D-glucose using the 2D sketcher.
A zigzag structure (or Natta projection) is a
way of representing three-dimensional
molecules in which the carbon skeleton is
drawn in a continuous “w” shape (hence the
name zigzag structure), and the
stereochemistry at each carbon is denoted
with wedges and dashes.

Learn More: Take a look at our lesson on
Stereoisomers to learn more about the
three-dimensional, spatial arrangement of
atoms and molecules!

1. In the toolbar, select > Edit > 2D
Sketcher

○ The 2D Sketcher panel opens
2. Draw the zigzag structure of

D-glucose exactly how it is shown in
Figure 5-2.

○ Go to the Draw Tools on the
left

○ Create the carbon skeleton by
choosing the C atom and
clicking in the 2D workspace.

○ A methyl group appears
○ Drag rightwards from the

methyl group to draw a carbon
skeleton consisting of seven
bond lines

○ Add an OH group to the
leftmost tail end of the
skeleton by selecting the O
atom from Draw Tools and
clicking on the end of the bond
line
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Figure 5-3. Saving D-glucose.

○ Add an aldehyde group to the
rightmost tail end of the
skeleton by changing the last
bond line to a double bond and
adding an O atom to the end
of the bond line

○ Create a wedge bond on the
second carbon from the left by
choosing the wedge bond and
dragging up from the carbon
atom

○ Add an OH group to the
wedge by selecting the O atom
from Draw Tools and clicking
on the end of the wedge bond

○ Create a dashed bond on the
third carbon atom from the left
by choosing the dashed bond
and dragging down from the
carbon atom

○ Add an OH group to the
dashed bond by selecting the
O atom from Draw Tools and
clicking on the end of the
dashed bond

○ Repeat the steps for creating a
dashed bond with an OH
group for carbon atoms 4 and
5 as shown in Figure 5-2

3. Click on Save as New and for Input
Entry Title, write D-glucose

4. Click OK

Question #1: How many chiral carbons does a D-glucose molecule have? Identify the
positions of each chiral carbon and list them below.
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Question #2: Take a screenshot of your D-glucose structure in the 3D workspace and paste it
below. What do you notice about the directions of each OH group?

Question #3: Based on your observation in Question 2, what conclusions can you draw about
wedged and dashed bonds?

Part 2. Translating a 3D structure to a 2D Fisher projection

Sugars can be drawn in the straight chain form as either Fischer projections or as zigzag
formulas that organic chemists often prefer. When drawing Fischer projections, the aldehyde
group is written at the top, and the H and OH groups that are attached to each chiral carbon
are written to the right or left. The arrangement of the atoms distinguishes one stereoisomer
from the other.

5. Using the 3D structure of D-glucose you generated using the 2D sketcher and 3D
workspace, sketch a Fischer projection of the same molecule in the space below.
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Question #4: Sketch your Fischer projection of D-glucose here.

Question #5: What is one advantage of Fischer projections over zigzag structures of organic
molecules?
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Figure 5-4. Polymer Builder panel with the
Carbohydrate default parameters.

Figure 5-5. Composition tab and running the
job.

Part 3. Build and compare the structures
of cellulose and amylose

6. Go to Tasks > Structure Builders >
Polymer

○ The Polymer Builder panel
opens

7. For Monomer type select
Carbohydrate

○ The panel updates to the
specialized carbohydrate
parameters

8. Leave End Groups as the default: H
9. For amylose, leave alpha-D-Glucose

as monomer A, which again is the
default.

10. Go to the Composition tab

Note: Hydroxyl is also available as an end
group selection, if needed. To see which end
of the monomer is the head versus the tail,
hover over the molecular formula and the 2D
Sketch will appear with R1 and R2 labeled for
head and tail, respectively

11. In the Composition tab, set the
number of monomers to 12

○ We will construct a 12mer
○ The Total atoms per chain: and

Molecular weight: update
accordingly

We do not need to change anything in the
Chain Growth tab.

12. Change the Job name: to
amylose_12mer

13. Click Run
○ The job should be completed

within a few minutes.
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Figure 5-6. Updating the style to
ball-and-stick.

Figure 5-7. Selecting Tile view.

14. Once the job is incorporated, include
poly(alpha-D-Glucose) in the
workspace

15. Go to the Style dropdown and select
Apply ball-and-stick representation

16. For cellulose, repeat steps 1 to 10
using the monomer beta-D-Glucose
instead

17. Change the Job name: to
cellulose_12mer

○ The job should be completed
within a few minutes.

18. Close the Polymer Builder panel
19. Once both jobs are incorporated,

include poly(alpha-D-Glucose) and
poly(beta-D-glucose) in the
workspace

20. Go to the plus icon in the bottom right
corner of the Maestro interface and
select Tile view

21. Play around with your mouse and
scroll wheel to zoom in/out into the
structures.
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Question #6: Take a screenshot of your poly(alpha-D-Glucose) and poly(beta-D-Glucose)
structures side-by-side in the tile view. Paste your screenshot in the table below. What
similarities and differences do you observe between the two polymers? Note them down in the
table below.

Amylose and cellulose side-by-side screenshot:

Similarities Differences
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6. Individual Exercise

Recall from Section 3.1 of this lesson that apart from glucose, fructose is also another
well-known monosaccharide and is the natural sugar found in fruits. Fructose has the
same chemical formula as glucose, but the way the atoms are arranged in each
carbohydrate molecule differ.

1) Repeat steps 1- 4 of Part 1 of the computational exercise for a D-fructose
molecule instead. The zigzag structure of D-fructose is given below.

2) Take a screenshot of your D-fructose molecule in the 3D workspace and paste it
below.
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3) Take a screenshot of your D-fructose and D-glucose structures side-by-side in
the tile view. Paste your screenshot in the table below. What similarities and
differences do you observe between the two monomers?

D-fructose and D-glucose side-by-side screenshot:

Similarities Differences

4) Draw a Fischer projection of a D-fructose molecule.
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7. Summary, Additional Resources, and References

In this lesson, students learned how to use the 2D Sketcher and Polymer Builder to
construct simple and complex carbohydrates, as well as translate the 3D structures to
2D representations. Using Maestro, students were able to interact with the carbohydrate
polymers using the graphical user interface to zoom in/out, as well as compare and
contrast each structure using Tile view.

For further learning:

● Polysaccharides - properties, functions, and applications
● Introduction to Computational Chemistry, 3rd Edition
● Essentials of Computational Chemistry: Theories and Models, 2nd Edition
● Molecular Modelling: Principles and Applications, 2nd Edition
● See the Jaguar help documentation

8. Glossary of Terms

Entry List - a simplified view of the Project Table that allows you to perform basic
operations such as selection and inclusion

Included - the entry is represented in the Workspace, the circle in the In column is blue

Project Table - displays the contents of a project and is also an interface for performing
operations on selected entries, viewing properties, and organizing structures and data

Recent actions - This is a list of your recent actions, which you can use to reopen a
panel, displayed below the Browse row. (Right-click to delete.)

Scratch Project - a temporary project in which work is not saved. Closing a scratch
project removes all current work and begins a new scratch project

Selected - (1) the atoms are chosen in the Workspace. These atoms are referred to as
"the selection" or "the atom selection". Workspace operations are performed on the
selected atoms. (2) The entry is chosen in the Entry List (and Project Table) and the row
for the entry is highlighted. Project operations are performed on all selected entries

Working Directory - the location that files are saved
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https://conductscience.com/polysaccharides-properties-functions-and-applications/
https://www.wiley.com/en-us/Introduction+to+Computational+Chemistry%2C+3rd+Edition-p-9781118825990
https://www.wiley.com/en-us/Essentials+of+Computational+Chemistry%3A+Theories+and+Models%2C+2nd+Edition-p-9780470091821
https://www.pearson.com/us/higher-education/program/Leach-Molecular-Modelling-Principles-and-Applications-2nd-Edition/PGM251961.html
https://www.schrodinger.com/sites/default/files/s3/mkt/Documentation/2021-3/docs/Documentation.htm#jaguar_command_reference/jaguar_command_referenceTOC.htm


Workspace - the 3D display area in the center of the main window, where molecular
structures are displayed

Biological macromolecule - a large, organic molecule such as carbohydrates, lipids,
proteins, and nucleic acids

Monosaccharide - a carbohydrate composed of one type of sugar

Disaccharide - a carbohydrate formed when two monosaccharides are joined together
via a condensation reaction

Polysaccharide - a carbohydrate composed of a large number of monosaccharides

Glycosidic linkage - a type of covalent bond that joins a carbohydrate molecule to
another group, which may or may not be another carbohydrate
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